Brian’s Quick and Easy Statistics 

Background: Sources of Distribution

I have just measured all the student desks in my classroom.  The lengths of the desks vary from 33.9 inches to 34.9.  The average length is 34.3 inches. What do these numbers tell us about the desks and why aren’t they all the same?

Anytime you measure something, like the length of a desk, there is some amount of uncertainty.  What is the actual length of the desk – is it what you read off the tape?  What if you did it again – it should be the same right?  If you were careful you should get the same measurement.  But what if you were measuring down to the micron?  Then the length you measure would be effect by tiny things like the angle of the tape, any bumps in the surface etc.  Because of these small effects, you would likely get slightly different results each time.  In general anytime you measure a continuous variable (e.g. length, not something discrete like the number of cars in a parking lot) several times you can get several different results.  The spread of the results is called measurement error or random error.  The amount of measurement error depends on the type of measurement technique you use (e.g. a yard stick or a micrometer).  Because measurement error is random you are equally likely to measure high as low. Other systematic errors can push the measurement in a particular direction and skew the results (e.g. a stretched out tape measure).  Measurement error and systematic error are harder to identify in studies of people.  If you ask someone the same question at different times – you can sometimes get different answers.  It is often hard to say if these errors are random or systematic.  It might have to do with how the question is asked or even who is asking. We always try to minimize error and if that is not possible to identify and quantify them. 

Beyond measurement error, the desks have different measurement because there is real variation in the population.  Say you have several desks and you measure all of them.  Even though they look similar, you will likely find the different desks have slightly different lengths.  A collection of measurements like this is called a distribution.  For most things you measure the distribution will form a bell curve around the mean value.  We call this a normal distribution around a center point (Figure 1).  However, some populations have abnormal distributions (Figure 2).  Abnormal distributions are often due to ceiling or floor effects.  For example the income of households has a floor effect (you cannot make less than zero dollars) but an unlimited ceiling.  Lots of people are close to the floor but few people are much higher than average.
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Figure 1. A nice normal distribution. Note a small floor effect (driving headway from ops.fhwa.dot.gov)
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Figure 2. A Skewed distribution 

(US household income in 2005 from visualizingeconmics.com)


Measuring the Distribution

Two key pieces of information for a distribution are its mean and its standard deviation.  When you report data in your research paper, you should always give both the mean and standard deviation for every measurement you report (even if the differences are not significant).  For example, the average income in 2005 was  $63.344 sd

The mean is simply the sum of all the measures divided by the number of measures ((xi/n).  The standard deviation (written as s or () is a measure of the average distance between each point and the mean.  The exact equation is given below (s2 is called “variance” and s is the standard deviation):
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The standard deviation can tell you how spread out your data is.  It can also tell you if an individual measurement is an outlier or not.  If your measurement is less than one standard deviation from the mean, it is well in the center of the range.  If it is more than two standard deviations from the mean it is fairly exceptional.  

Here are the rules for a normal distribution (does not apply to a skewed distribution):

· 68.2% of measurements fall within one standard deviation of the mean

· 95.4% of measurements fall within two standard deviations of the mean

· 99.8% of measurements fall within three standard deviation of the mean

In SPSS you can get the mean and standard deviation from the Analysis menu by selecting Descriptive Statistics for your field.  In Excel you can insert an AVERAGE or STDEV function into a field and specify a range of data.  

Comparing Distributions – showing differences

Lets say you have two measures: the volume of gum under tables in your room and the volume under tables in the room next door.  You can compare these two distributions by comparing the means.  Lets say room A has a mean of 6.78 (sd 2.13) and room B has a mean of 7.08 (sd 1.4) pieces of gum per table.  These means tell us that room B has 0.30 more gum on average than room A.  Yes there is a difference, but we don’t know if this difference is important or not.  If you measured 100 rooms would these two be relatively close to each other in a bell curve?  Or is there something about the kids in one of these rooms that leads to an unusual amount of gum compared to the other.

The measurement error and variations in the population make this an impossible question to answer conclusively.  It is always possible – but unlikely – for unusual measurements to happen just by chance (think monkeys typing works Shakesphere).  What we can do is say how likely or unlikely it is that the difference in the means is just do to chance.  In other words, if you picked two other samples what are the odds of seeing the same differences?  For the gum – if you picked two other rooms C and D, what are the chances of seeing a 0.30 difference between the means.  

Lets think about this the opposite way – two distributions have almost identical means.  Does this mean these classes are the same?  No – you can’t prove sameness either.  Two classes could get the same mean for different reasons (one class might have less gum except on a single desk which is covered). All we can say is that there is no statistical evidence for any differences.  We can hypothesize that the classes are basically the same.

We call this the null hypothesis – that two groups are the same.  Our goal is often to demonstrate that this hypothesis is most likely false.

	Null Hypothesis: There is no real difference between the two groups or no real effect of the treatment.


There is always some possibility that the differences between distributions is due to chance.  But often this is highly unlikely.  In education it is standard to report differences where there is no more than a 5% chance that the null hypothesis is true.  These differences are deemed significant.  Some results are reported as “approaching significance”.  Keep in mind that the 5% limit is difficult to achieve, but also if you do 20 studies that are not significant, you will probably get a false-significant finding on one of them.

Just because the data does not show a significant difference does not mean the null hypothesis is true.  It only means that there is not enough evidence that it is false. Often with more students or a better measurement, the difference can be demonstrated to be significant.  If you have a non-significant finding, you can still discuss the results and the differences in the means, but you cannot conclude anything about that difference.

The standard tool for comparing distributions is the t-test.  This test assumes that the sample is reasonably normal (not heavily skewed) and that you have at least 12 measurements in each sample.  The t-test is really the computing of the t statistic (or t value).  The formula for the t statistic is given below, but you don’t need to know it.  The computer will calculate it for you.  Notice that a key variable is n, the size of the sample.  The sample size is also a key element of the degrees of freedom for the measurement (pick the smaller n: df = n -1).
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T-test in Excel
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To run a t-test in Excel you need to first install the Data Analysis add in.  To install this feature, go to the Tools menu, select “Add-Ins…” (see picture on right) and check “Analysis ToolPak”.  This will add a new menu item to the Tools menu called “Data Analysis…”.  If you do not have the Analysis ToolPak option, you need to get it from your installation disk.  Note that in Excel 2008 for Windows the Add-Ins are located by clicking the office icon (upper left corner) and selecting “Excel Options”.  The analysis options will show up on the Data toolbar (there is no Tools menu) once the Analysis ToolPak is installed.
Select “Data Analysis…” from the Tools menu.  This brings up a menu of analysis options.  There are three t-test options.  Here are the rules for the three options:

· T-test: Paired Two Sample Means – use this for comparing results from the same students at different times (e.g. a pre and a post test)

· T-test: Two-Sample Assuming Equal Variances – use this for comparing results from two groups (e.g. students in period 1 vs. period 2) where you expect their results to be similar (approximately the same spread of the data).

· T-test: Two-Sample Assuming Unequal Variances – use this for comparing two groups where they are very different (different sized groups, larger spread in one group).  This is less common than equal variances.
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Select the appropriate test for your data.  You will then see a dialog box where you can specify the input (data to use) for the test.  See the picture above.  Click in “Variable 1 range” and highlight (click and drag on your spreadsheet) the first set of data to use.  Then click in “Variable 2 range” and select that data.  If you selection includes labels in the first row (recommended) then click the box for labels.  Select OK to see the results.

Excel will not run a paired samples t-test if there are different numbers of data points.  You will need to move the rows with the missing data outside of the range for the test.  It can be useful to sort your data first so those with missing scores are at the end of the list.
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The results are placed in a table on a new worksheet (see image on the right).  The table shows the mean and variance (standard deviation squared) for each set of data. The it lists the observations (N), a correlation of the data (see below for more about this statistic).  The “df” is degrees of freedom.  Then the key t-statistic.  This is needed when you report the results of the data.  This is followed by two p-values.  These are the probability for getting this statistic given the relative means and variance.  If the p-value is below 0.05 than this is considered significant.

P-values are computed for one-tail and two-tail comparisons.  The two tail comparison is more conservative and should be used most of the time.  You use one-tail when you have a clear hypothesis that one variable should be higher than the other.  The two-tail statistic is used when you simple want to find out if the scores are different, but you don’t have a clear hypothesis why one would be higher than the other.  In the results table shown above, the t-statistic is -3.54 and the one tailed probability is .00059 – a significant result!  The likelihood of getting this difference in means (~.62) from two trials of the same measurement is less that .06%.  
T-test in SPSS
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To run a t-test in SPSS you go to the Analyze menu: Compare Means.  The two comparisons we use are Independent-Samples T Test and Paired-Samples T Test.  For comparing two classes (e.g. period 1 vs period 2) or two groups of students (e.g. boy vs. girls) within a class, choose independent samples.  To compare pre- and post-test data for the same group of students use paired samples. 

When doing tests of paired samples t-tests, you will select the two variables (columns) to compare.  Click on the first variable – you will see it indicated below, then the second.  Then click the arrow to move the variable pair to the right side.  You can select as many pairs as you like.  Each pair will be analyzed independently.  You may use the same variable in more than one pair.

When doing tests of independent samples you need to have all the data in one column and a second column to identify the two groups to compare.  For example, you could have one column showing what period each student is in (1 or 2) and one column for their test scores.  For the grouping variable you need to have a numeric variable and then specify the groups (which numbers).  You may need to create a new variable (or recode a text variable to be numeric) for this purpose.
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The output for a t-test is generally two tables.  The first has descriptive statistics (N, mean, Std Dev.) for the two samples, the second table gives the t-value, the degrees of freedom (df) and the significance (aka probability or p value).  There are other columns that you can generally ignore.  For each comparison there are two sets of numbers, one for assuming equal variance and other for not assuming it. These numbers should be similar; in most cases you should report the top one (equal variances assumed).  

P-values are computed for one-tail and two-tail comparisons.  The one tail comparison is used most of the time.  You use one-tail when you have a hypothesis that one variable should be higher than the other.  The two-tail statistic is used when you simple want to find out if the scores are different, but you don’t have a clear hypothesis why one would be higher than the other.
The p value (significance) is the key piece of information.  If this number is below .05 the comparison is judged to be significant.   With this you are allowed to conclude that something (e.g. good teaching, sunspots) caused a difference between the two sample.  Identifying the cause is up to you – hopefully the design of your study will limit the possibilities.  
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Reporting T-test Data

Test data is generally reported in tables and/or in the text of the paper.  To report data in the text you should indicate one score was significantly higher than the other and then put the test info in parenthesis.  As you see below you indicate the type of test by identifying the variable (t) and give the degrees of freedom in parenthesis and give the p level.  Some people like to give the exact p value (e.g. p = .037) while others prefer the old style where you round to the nearest increment (e.g. p<.01).

	The results show that students in the hands-on classes preformed significantly better than those in the textbook science classes in only one of the long performance assessments.  The differences in the flatworms assessment (t(19)=1.19, p<.05) do suggest small advantage for the hands on classes.


In tables, you generally list all the means and standard deviations and indicate which comparisons were significant (e.g. with an *).  Note that they std dev. Is listed in parentheses with the means.
	
	Multiple choice
	Short performance assessments
	Long performance assessments

	Hands-on Classes

(N=20)
	6.16 (0.09)
	3.98 (0.15)
	4.04 (0.15)
	4.61 (0.12)
	5.39* (0.11)

	Textbook Science Classes (N=20)
	7.16 (0.09)
	3.68 (0.15)
	4.24 (0.17)
	4.64 (0.12)
	4.99* (0.11)


Table 1: summary of results of Authors et al (in press).

*HO-TX difference is significant p<.05
Comparing Distributions – showing similarities

Sometimes you want to show that two things that are not obviously connected really are related to each other.  For example: the attractiveness of a professor and their teaching rating.  These variables are not intentionally connected but you could imagine (hypothesize) a relationship.  To test this you would look for a correlation between a rating of attractiveness (by some independent observers) for several professors and their teaching rating.  We can test the distributions to see if professors who score highly on one variable (attractiveness) are more likely to score higher on the other (teaching rating).  

A good way to think about a correlation is with a scatter plot graph.  If you use one variable as the x-axis and the other as the y-axis and plot each professor, that is a scatter plot (see below).  If there is a correlation between the variables, then it should be visible from the spread of the data.  The most common type of correlation is a linear correlation – but other types of correlations are possible (e.g. parabolic, exponential).  
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A correlation does not imply a direct relation between variables.  Just because a professor is attractive doesn’t mean that they will get high ratings.  But there is a higher likelihood depending on the strength of the correlation.  The strength of the correlation is indicated by the r-statistic.  This can vary from -1 (perfect negative correlation) to 0 (no correlation) to 1.0 (perfect positive correlation).  A weak correlation may indicate that the variable are related but have only a little influence on each other or that other variables are more important (e.g. how well a teacher teaches).  The r-statistic is related to the 
As with t-tests, we report correlations when they are high enough that that they are unlikely the results of a strange sample of data.  Thus we will compute p-value as well as the r-statistic.  Again the standard is typically p> .05 or a 1-in-20 chance that the result is due to randomness.  The larger the data sample the more likely you are to find a low p-value, even if the correlation is not very strong.

To test the correlation between two numerical variables we typically use the Pearson correlation (this is a particular algorithm that is based on assumptions that the sample is reasonably “normal”).  For categorical data such as coding of a free response question, another test, chi-squared is typically used (not discussed in this document).

Correlations in Excel
To run a correlation, you must first install the Analysis ToolPak as described in the section on T-tests in Excel.  From the Tools menu, select “Data Analysis…”  and choose “Correlation”.  For this analysis there is only a single input range.  Here you select the data from all the columns that you want to correlate with each other.  So if you want to compare two columns of data, simply copy and paste the columns so they are next to each other and select both as part of the input range.  If you have included labels for your variables in the first row of your range, click the “Labels in the First Row” option (recommended).  

If you select more than two columns, the process will compare every possible pairing of variables (columns) and report the data in a half table as shown below.  Here each variable label is listed both on the first row and the first column.  For each pair of variables a correlation r-statistic is calculated.  So in the case in the image, if you want to see if “concepts” is strongly correlated with “activities”, look to the row 7 (activities) and then over to column D (concepts) and see an r-statistic of .297745.  Note that the diagonal entries (e.g. “read” correlated with “read”) are always 1 – perfectly correlated!  
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Unfortunately Excel does not calculate the probability (significance) of these values.  However a number of websites have online calculators to calculate “P from r” (e.g. http://faculty.vassar.edu/lowry/tabs.html).  To use these, simply input the correlation value and the degrees of freedom (N-2 for correlations where N is the number of data pairs).  Also you can use the r-statistic to calculate the percent of variation.  The value of r2 is the percentage of variance in one variable that can be attributed to the second variable (and vice versa).  

Correlations in SPSS
To do these tests in SPSS, go to the Analyze menu and choose “Correlate” “Bivariate”.  You will be able to select all numerical variables.  Here you can select as many variables as you want by moving variables from the list on the left to the list on the right.  The computer will test for correlations for every combination of variables that you select.  You should indicate that you want Pearson correlation and two-tailed (except in unusual situations).  
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The output of a correlation test is a grid showing all the combinations of variables.  For each square you will see the Pearson Correlation (r-statistic), Significance (p-value) and the N (number of cases used).  The N will indicate all the cases where there is a value for both variables.
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Reporting Correlation Data

To report a correlation you simply indicate it in the text of the article.  You report the r-statistic with the degrees of freedom in parentheses, and the p value. The degrees of freedom for correlations is N-2. 

Pearson’s test showed a positive correlation between the variables, r(58) = .63, p < .001 
Brian’s Quick and Easy Stats version 3 (2/2009)

Notes for Excel:

Excel 2008 includes a function TTEST(array1, array2, tails, type) – this function only produces the probability measure associated with the test (not the t-statistic).

Excel Tricks:

· Use “Replace” (edit menu) to change multiple choice answers (e.g. “yes” “highly”) into numeric data.  Be careful to highlight the columns you are interested in before doing the replace.  That way you won’t accidentally replace text in some unrelated question.  

· Use the sort function to put incomplete records at the end of the spreadsheet.  Be sure that all your data is highlighted before doing any sorting.

Notes for SPSS:

SPSS can import your Excel files, but it will do a much cleaner import if you:

· Put all students on the same worksheet with ID data in the first row

· Create a header row at the top of your file with field names (names < 9 characters)

SPSS Tricks

· Use “Recode into New Variable” to create a numeric version of a string variable.

· For complex analysis create scripts for all the data changes.

· You can split the file by any variable (e.g. gender) so you can run analysis separately for each split.  

Just tell me what I need to do!

Can’t do that, but here are some useful rules of thumb for different types of data:

Data from a single class (no control)
Typically you are looking at classwork, test and perhaps survey data 

Start with Descriptive Statistics to summarize the students’ answers.  This means that you can look at the mean and standard deviation for any numerical answers.  For essay or short answer questions you can make up a coding key and assign a code to each response.  Then you can look at the frequency of the different types of responses.  This would help you say something like “students like X much more than they like Y.”  If the standard deviation seems high then you could conclude that, “there is a lot of variation in students’ responses.”
You can also look for correlations in students’ answers.  This means that you look for trends in the responses (e.g. students who like X seem to really not like Y).  Not all correlations are interesting.  Some questions are correlated but are obvious – for example homework score and final grade are almost always correlated.  Look for the non-obvious correlation.

Finally you can look at pre and post data for this class.  A one-sample t-test will enable you to see if the class has changed in any way from pre to post.  If the p value is >.05 then there is a significant difference - this is not a very high standard, we hope that students learn something.  You can tell more by computing the effect size.

Data from multiple classes

Typically with multiple classes there is something different about the classes (either intentional or accidental).  To see if these differences lead to a difference in some interesting outcome you can do a two-sample t-test.  This will tell you if the difference in the means is significant.  

If you have pre and post data you can do several analysis.  First with the pre data you can see if the classes are evenly matched (if there is no significant difference).  If they are, then you can compare the post data to see if there is a significant difference in learning.  If the pre data shows some differences it often makes sense to calculate a gain score (post-pre).  Then you can conduct a t-test on the gains to see if one class learned more than another.  
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